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1 Product introduction

● Product comparison

● Product views

● Finishing accessory views

● Product hardware setup and software installation

For more information:

In the US, go to www.hp.com/support/colorljM855.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Product comparison

  M855dn

A2W77A

M855xh

A2W78A

M855x+

A2W79A

M855x+

D7P73A

Paper handling Tray 1 (100-sheet capacity)

 Tray 2 (500-sheet capacity)

 3x500-sheet paper feeder

NOTE: Optional for the M855dn 
model. If this input accessory is 
installed, then any of the optional 
finishing accessories can also be 
installed with the M855dn model.

   

 3,500-sheet high-capacity input trays

NOTE: Optional for the M855dn 
model. If this input accessory is 
installed, then any of the optional 
finishing accessories can also be 
installed with the M855dn model.

  

 Automatic duplex printing

 Optional 1x500-sheet feeder with 
cabinet. Available in Europe, the 
Middle East, Africa, and Asia-Pacific 
Countries/Regions

NOTE: If this input accessory is 
installed, then any of the optional 
finishing accessories can also be 
installed with the M855dn model.

   

 Optional stapler/stacker finishing 
accessory

 

 Optional stapler/stacker with 2/4 hole 
punch finishing accessory

Available in Europe, the Middle East, 
Africa, and Asia-Pacific Countries/
Regions

 

 Optional booklet maker finishing 
accessory

Available in Europe, the Middle East, 
Africa, and Asia-Pacific Countries/
Regions

 

 Optional booklet maker with 2/3 hole 
punch finishing accessory

Available in North America and Latin 
America

 

2 Chapter 1   Product introduction ENWW



  M855dn

A2W77A

M855xh

A2W78A

M855x+

A2W79A

M855x+

D7P73A

 Optional booklet maker with 2/4 hole 
punch finishing accessory

Available in Europe, the Middle East, 
Africa, and Asia-Pacific Countries/
Regions

 

Connectivity 10/100/1000 Ethernet LAN 
connection with IPv4 and IPv6

 Easy-access USB port for printing 
without a computer and upgrading 
the firmware

 HP near-field communications (NFC) 
and Wireless Direct accessory for 
printing from mobile devices

   

 Optional HP NFC and Wireless Direct 
accessory for printing from mobile 
devices

 

Storage HP High-Performance Secure Hard 
Disk

 

Control-panel display and 
input

Touchscreen control panel

Print Prints 46 pages per minute (ppm) on 
A4 and 45 ppm on letter-size paper

 Easy-access USB printing (no 
computer required)

Mobile printing solutions

For more information 
about Mobile printing 
solutions see:

www.hpconnected.com

www.hp.com/go/
LaserJetMobilePrinting 
(English only)

www.hp.com/go/
eprintsoftware

www.hp.com/go/
eprintenterprise

www.google.com/
cloudprint/learn

www.hp.com/go/airprint

● HP ePrint via email

● HP ePrint software1

● HP ePrint app

● HP ePrint Enterprise

● HP ePrint Home & Biz

● HP Printer Control app

● Google Cloud Print

● AirPrint
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  M855dn

A2W77A

M855xh

A2W78A

M855x+

A2W79A

M855x+

D7P73A

Supported operating 
systems2, 3

Windows XP SP3 or later, 32-bit and 
64-bit

NOTE: The software installer does 
not support the 64-bit version, but 
the print driver supports it.

NOTE: Microsoft retired mainstream 
support for Windows XP in April 2009. 
HP will continue to provide best-
effort support for the discontinued XP 
operating system.

 Windows Vista, 32-bit and 64-bit

NOTE: Windows Vista Starter is not 
supported by the software installer or 
the print driver.

 Windows 7 SP1 or later, 32-bit and 
64-bit

 Windows 8, 32-bit and 64-bit

 Windows 2003 Server SP2 or later, 
32-bit and 64-bit

NOTE: The software installer does 
not support the 64-bit version, but 
the print driver supports it.

NOTE: Microsoft retired mainstream 
support for Windows Server 2003 in 
July 2010. HP will continue to provide 
best-effort support for the 
discontinued Server 2003 operating 
system.

 Windows Server 2008, 32-bit and 64-
bit

 Windows Server 2008 R2, 64-bit

 Windows Server 2012, 64-bit

 Mac OS X 10.6, 10.7 Lion, and 10.8 
Mountain Lion

1 The HP ePrint Software supports the following operating systems: Windows® XP SP3 or greater (32-bit) up to ePrint Software version 
3; Windows Vista® (32-bit and 64-bit); Windows 7 SP 1 or later (32-bit and 64-bit); Windows 8 (32-bit and 64-bit); and Mac OS X 
versions 10.6, 10.7 Lion, and 10.8 Mountain Lion.

2 The list of supported operating systems applies to the Windows PCL 6, UPD PCL 6, UPD PCL 5, UPD PS, and Mac print drivers and to 
the in-box software installation CD. For a current list of supported operating systems, go to www.hp.com/support/colorljM855 for 
HP's all-inclusive help for your product. If you are located outside the US, go to www.hp.com/support, select a country/region, and 
then click Drivers & Software. Enter a product name or number. In the Download Options area, click Drivers, Software & Firmware. 
Click the operating system version, and then click the Download button.

3 The HP Software Installer CD installs the HP PCL 6 discrete driver for Windows operating systems along with other optional software. 
Mac installer software is not included on the CD. The CD provides steps to download the Mac installer software from www.hp.com. The 
steps to download the Mac installer software are as follows: Go to www.hp.com/support, select the country/region, and then click 
Drivers & Software. Enter a product name or number. In the Download Options area, click Drivers, Software & Firmware. Click the 
operating system version, and then click the Download button.
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Product views
● Product front view

● Product back view

● Interface ports

● Control-panel view

Product front view

M855x+M855xhM855dn

1 2 3 4 

5
6

7
8

9

10 11  

1 Output bin

2 Control panel with color touchscreen display (tilts up for easier viewing)

3 Easy-access USB port (for printing without a computer)

NOTE: An administrator must enable this port before use.

4 Hardware integration pocket (for connecting accessory and third-party devices)

5 Right door (access to the fuser and for clearing jams)

6 Tray 1

7 Tray 2

8 On/off button

9 Front door (access to the toner cartridges and imaging drums)

10 3x500-sheet paper feeder

11 3,500-sheet high-capacity input tray
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Product back view

1

2

3

4

1 Formatter (contains the interface ports)

2 Lever to lock the product to the 3x500-sheet feeder (M855xh model only)

3 Power connection

4 Model and serial number label
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Interface ports

1

2

3

4

5

1 Slot for a cable-type security lock

2 Local area network (LAN) Ethernet (RJ-45) network port

3 USB port for connecting external USB devices (this port might be covered)

4 Hi-Speed USB 2.0 printing port

NOTE: For Easy-access USB printing, use the USB port near the control panel.

5 Foreign interface harness (for connecting third-party devices)
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Control-panel view

The Home screen provides access to the product features and indicates the current status of the product.

You can return to the Home screen at any time by touching the Home button on the left side of the product 
control panel. You can also touch the Home button in the upper-left corner of most screens.

NOTE: The features that appear on the Home screen can vary, depending on the product configuration.

4 5 6 7 8 9

10

11

1
2
3

1 Home button and light Touch to return to the product Home screen at any time.

2 Product status The status line provides information about the overall product status.

3 HP logo or Home button On any screen other than the Home screen, the HP logo changes to a Home  button. Touch the 

Home  button to return to the Home screen.

4 Stop button Touch the Stop button to pause the current job. The Job Status screen opens, and then you can 
cancel or continue the job.

5 Sign In or Sign Out 
button

Touch the Sign In button to access secured features.

Touch the Sign Out button to sign out of the product if you have signed in for access to secured 
features. After you sign out, the product restores all options to the default settings.

6 Language Selection 
button

Touch the Language Selection button to select the language for the control-panel display.

7 Sleep button Touch the Sleep button to put the product into Sleep mode.

8 Network button Touch the Network button to find information about the network connection.

9 Help button Touch the Help button to open the embedded help system.
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10 Scroll bar Touch the up or down arrows on the scroll bar to see the complete list of available features.

11 Features Depending on the product configuration, the features that appear in this area can include any of the 
following items:

● Quick Sets

● Retrieve from USB

● Retrieve from Device Memory

● Job Status

● Supplies

● Trays

● Administration

● Device Maintenance
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Finishing accessory views
These finishing devices are available as accessories for this product.

● Stapler/stacker and stapler/stacker with hole punch

● Booklet maker and booklet maker with hole punch

Stapler/stacker and stapler/stacker with hole punch

2

1

5 6 

7 

8 

9 

3
4

1 Stapler/stacker output bins

2 Stapler/stacker output slot

3 Front door

4 Stapler 1

5 Top left door

6 Hole-punch unit (hole punch models only)

7 Hole-punch alignment knob (hole punch models only)

8 Chad collector (hole punch models only)

9 Hole-punch door (hole punch models only)
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Booklet maker and booklet maker with hole punch

3

2

9  10 

 11 

12

13

5
6

1
4

7 8

14

15

1 Booklet output bin

2 Stapler/stacker output bins

3 Stapler/stacker output slot

4 Lower booklet door (access for clearing jams)

5 Front left door

6 Stapler 1

7 Lower paper delivery guide

8 Upper paper delivery guide

9 Top left door

10 Hole-punch unit (hole punch models only)

11 Hole-punch alignment knob (hole punch models only)

12 Chad collector (hole punch models only)

13 Hole-punch door (hole punch models only)

14 Paper-advancement knobs for clearing jams

15 Saddle-stitch carriage, access to stapler 2 and stapler 3
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Product hardware setup and software installation
For basic setup instructions, see the Hardware Installation Guide that came with the product. For additional 
instructions, go to HP support on the Web.

In the US, go to www.hp.com/support/colorljM855 for HP's all-inclusive help for your product.

Outside the US, follow these steps:

1. Go to www.hp.com/support.

2. Select your country/region.

3. Click Product Support & Troubleshooting.

4. Enter the product name (HP Color LaserJet Enterprise M855), and then select Search.

Find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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2 Paper trays

● Configure trays for paper type and size

● Load Tray 1

● Load Tray 2

● Load the 3x500-sheet trays

● Load the 3,500-sheet high-capacity tray

● Configure the default staple location

● Configure the default hole punch location

For more information:

In the US, go to www.hp.com/support/colorljM855.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Configure trays for paper type and size
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or paper type for a print job through the print driver or a software 
program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not display if you are printing from Tray 1, and Tray 1 is configured for the Any Size 
paper size and the Any Type paper type settings. In this situation, if the print job does not specify a tray, the 
product prints from Tray 1, even if the paper type and size settings in the print job do not match the paper 
loaded in Tray 1.

Configure a tray when loading paper

1. Load paper in the tray.

2. The tray configuration message displays on the product control panel.

3. Touch the OK button to accept the detected type and size, or touch the Modify button to choose a 
different paper size or type.

4. Select the correct type and size, and then touch the OK button.

Configure a tray to match print job settings

1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, a tray configuration message displays on the product control panel.

3. Load the tray with the specified type and size of paper, and then close the tray.

4. Touch the OK button to accept the detected type and size, or touch the Modify button to choose a 
different paper size or type.

5. Select the correct type and size, and then touch the OK button.

Configure a tray by using the control panel

You can also configure the trays for type and size without a prompt from the product.

1. From the Home screen on the product control panel, scroll to and touch the Trays button.

2. Touch the line for the tray that you want to configure, and then touch the Modify button.

3. Select the paper type and size from the lists of options.

4. Touch the OK button to save your selection.
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Load Tray 1
CAUTION: To avoid jams, never add or remove paper from Tray 1 during printing.

1. Open Tray 1.  

2. Pull out the tray extension to support the paper.  

3. Load paper in the tray. See Table 2-1 Tray 1 paper 
orientation on page 16.

TIP: To achieve the highest print-quality, HP 
recommends that you load the paper long-edge 
first.
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4. Make sure that the paper fits under the fill line on 
the paper guides.

 

5. Adjust the side guides so that they lightly touch 
the paper stack, but do not bend it.

 

Table 2-1  Tray 1 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted, letterhead, or 
labels

Portrait 1-sided printing Face-down

Top edge toward the back of the product
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Table 2-1  Tray 1 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

  Automatic 2-sided printing Face-up

Top edge toward the back of the product

Prepunched Portrait 1-sided printing Face-down

Holes towards the right of the tray

Preprinted or letterhead Landscape 1-sided printing Face-down

Top edge toward the right

ENWW Load Tray 1 17



Table 2-1  Tray 1 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

  Automatic 2-sided printing Face-up

Top edge toward the left

Envelopes Short edge of the envelope 
feeding into the product

1-sided printing Face-down

Top edge toward the back of the product
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Load Tray 2

1. Open the tray.

NOTE: Do not open this tray while it is in use.

 

2. Adjust the paper-length and paper-width guides 
by squeezing the adjustment latches and sliding 
the guides to the size of the paper being used.

 

3. Load paper into the tray. Check the paper to 
verify the guides lightly touch the stack, but do 
not bend it.

NOTE: To prevent jams, do not overfill the tray. 
Be sure that the top of the stack is below the tray 
full indicator.

NOTE: If the tray is not adjusted correctly, an 
error message might appear during printing or 
the paper might jam.
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4. Close the tray.  

5. The control panel shows the tray’s paper type 
and size. If the configuration is not correct, follow 
the instructions on the control panel to change 
the type or size.

 

6. For custom-size paper, you need to specify the X 
and Y dimensions for the paper when the prompt 
displays on the product control panel.

 

Y
X

Table 2-2  Tray 2 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face-up

Top edge at the back of the tray
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Table 2-2  Tray 2 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

  Automatic 2-sided printing Face-down

Top edge at the back of the tray

 Landscape 1-sided printing Face-up

Bottom edge toward the right side of the tray

  Automatic 2-sided printing Face-down

Top edge toward the right side of the tray
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Table 2-2  Tray 2 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

Prepunched Portrait 1-sided printing Holes toward the left side of the tray

  Automatic 2–sided printing Holes toward the right side of the tray
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Load the 3x500-sheet trays
Use the following information to load paper in any of the trays in the 3x500-sheet feeder.

1. Open the tray.

NOTE: Do not open this tray while it is in use.

 

2. Adjust the paper-length and paper-width guides 
by squeezing the adjustment latches and sliding 
the guides to the size of the paper being used.

 

3. For any of the following paper sizes, also adjust 
the blue paper-stop lever in the left rear corner of 
the tray to the correct position, as indicated by 
the label in the tray:

● 12 x 18

● RA3

● 11 x 17

● A3

● SRA3
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4. Load paper into the tray. Check the paper to 
verify the guides lightly touch the stack, but do 
not bend it.

NOTE: To prevent jams, do not overfill the tray. 
Be sure that the top of the stack is below the tray 
full indicator.

NOTE: If the tray is not adjusted correctly, an 
error message might appear during printing or 
the paper might jam.

 

5. Close the tray.  

6. The control panel shows the tray’s paper type 
and size. If the configuration is not correct, follow 
the instructions on the control panel to change 
the type or size.

 

7. For custom-size paper, you need to specify the X 
and Y dimensions for the paper when the prompt 
displays on the product control panel.

 

Y
X
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Table 2-3  3x500-sheet tray paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face-up

Top edge at the back of the tray

  Automatic 2-sided printing Face-down

Top edge at the back of the tray

 Landscape 1-sided printing Face-up

Bottom edge toward the right side of the tray

  Automatic 2-sided printing Face-down

Top edge toward the right side of the tray
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Table 2-3  3x500-sheet tray paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

Prepunched Portrait 1-sided printing Holes toward the left side of the tray

  Automatic 2–sided printing Holes toward the right side of the tray
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Load the 3,500-sheet high-capacity tray
The 3,500-sheet high-capacity tray supports only A4 and Letter-size paper.

1. Open the right and left sides of the tray.  

2. On each side, adjust the paper-size lever to the 
correct position for the paper you are using.

 

LTR

A4
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3. Load full reams of paper into each side of the 
tray. The right side holds 1,500 sheets of paper. 
The left side holds 2,000 sheets of paper.

NOTE: For best results, load full reams of paper. 
Avoid dividing reams into smaller sections.

 

4. Close the right and left sides of the tray.  
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Configure the default staple location
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● Stapler/Stacker Settings

● Stapling

3. Select a staple location from the list of options, and then touch the Save button. The following options 
are available:

● None

● Top left

● Top right

● Two left

● Two right

● Two top

● Two top or left

NOTE: For documents with portrait orientation, the staples are on the left. For documents with 
landscape orientation, the staples are on the top.

Configure the default hole punch location
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● Stapler/Stacker Settings

● Hole Punching

3. Select a hole punch location from the list of options, and then touch the Save button. The following 
options are available:

● None

● Two left or top

● Two left

● Top right

● Two top

● Two bottom

● Three left

● Three right
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● Three top

● Three bottom

NOTE: For documents with portrait orientation, the holes are on the left. For documents with 
landscape orientation, the holes are on the top.
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3 Parts, supplies, and accessories

● Order parts, accessories, and supplies

● Replace the toner cartridges

● Replace the imaging drums

For more information:

In the US, go to www.hp.com/support/colorljM855.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Order parts, accessories, and supplies

Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter 
the product IP address or host name in the address/URL field. The 
EWS contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.

Parts and supplies

The following parts are available for the product.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are willing to 
pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is 
not provided under the HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request for no 
additional charge during the product warranty period.

Item Description Self-replacement options Part number

HP 826A Black toner cartridge Replacement toner cartridge Mandatory CF310A

HP 826A Cyan toner cartridge Replacement toner cartridge Mandatory CF311A

HP 826A Yellow toner cartridge Replacement toner cartridge Mandatory CF312A

HP 826A Magenta toner cartridge Replacement toner cartridge Mandatory CF313A

HP 828A Black imaging drum Replacement imaging drum Mandatory CF358A

HP 828A Cyan imaging drum Replacement imaging drum Mandatory CF359A

HP 828A Yellow imaging drum Replacement imaging drum Mandatory CF364A

HP 828A Magenta imaging drum Replacement imaging drum Mandatory CF365A

Staple Cartridge Refill Kit Replacement staple cartridge for 
Stapler 1 in all optional finishing 
accessories

Mandatory C8091A

2000-Staple Cartridge Kit (2-pack) Replacement set of staple cartridges 
for Stapler 2 and 3 in the optional 
booklet maker and booklet maker 
with hole punch finishing accessories

Mandatory CC383A

1x500 Sheet Feeder 1x500-sheet feeder (available in 
Europe, the Middle East, Africa, and 
Asia-Pacific Countries/Regions)

Mandatory C2H56A

3x500 Sheet Feeder Stand 3x500 Sheet Feeder Stand Mandatory C1N63A

1x3,500 Sheet high-capacity input 
tray

3,500-sheet high-capacity input tray Mandatory C1N64A
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Item Description Self-replacement options Part number

Booklet Maker/Finisher Booklet maker (available in Europe, 
the Middle East, Africa, and Asia-
Pacific Countries/Regions)

Mandatory A2W83A

Booklet Maker with 2/3 hole punch Booklet maker with 2/3 hole punch 
(available in North America and Latin 
America)

Mandatory A2W84A

Booklet Maker with 2/4 hole punch Booklet maker with 2/4 hole punch 
(available in Europe, the Middle East, 
Africa, and Asia-Pacific Countries/
Regions)

Mandatory CZ999A

Stapler/stacker Stapler/stacker Mandatory A2W80A

Stapler/stacker with 2/4 hole punch Stapler/stacker with 2/4 hole punch 
(available in Europe, the Middle East, 
Africa, and Asia-Pacific Countries/
Regions)

Mandatory A2W82A

Fuser Kit 110V Maintenance 110V fuser kit Mandatory C1N54A

Fuser Kit 220V Maintenance 220V fuser kit Mandatory C1N58A

Transfer & Roller Kit Replacement transfer unit and 
secondary transfer roller, feed 
rollers, and pick rollers

Mandatory D7H14A

Control Panel Assembly Kit Replacement control-panel 
assembly

Mandatory 5851-5950

Secondary Transfer Roller Kit Replacement secondary transfer 
roller

Mandatory D7H14-67902

ITB Service Kit Replacement transfer belt and 
secondary transfer roller

Mandatory A2W77-67904

Cassette Tray 2 Kit Replacement paper tray for Tray 2 Mandatory A2W75-67906

Tray 2-X Roller Kit Replacement rollers for Tray 2, the 
3x500-sheet trays, and the 3,500-
sheet high-capacity trays

Mandatory A2W77-67905

Tray 1 Roller Kit Replacement rollers for Tray 1 Optional A2W77-67906

Formatter Assembly Kit Replacement formatter Optional A2W77-67902

Formatter Assembly Kit (China and 
India)

Replacement formatter Optional A2W77-67903

SSM Drive Kit Replacement solid-state memory 
drive

Mandatory A2W77-67909

HDD Drive Kit Replacement HP High-Performance 
Secure Hard Disk

Optional A2W75-67905

FIPS HDD 500GB Replacement hard drive for US 
government models

Optional S2W79-67901
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Accessories

Item Description Part number

1x500-sheet feeder (available in Europe, the Middle East, 
Africa, and Asia-Pacific Countries/Regions)

Input accessory with one 500-sheet tray, and a storage 
cabinet and stand.

C2H56A

HP LaserJet 3x500 Sheet Feeder Stand Input tray accessory with three 500-sheet trays. C1N63A

HP LaserJet 1x3500 Sheet Feeder 3,500-sheet high-capacity input tray accessory, holds 
letter and A4-size paper

C1N64A

HP LaserJet Stapler/Stacker Stapler/stacker finishing accessory A2W80A

HP LaserJet Stapler/Stacker with 2/4 hole punch 
(available in Europe, the Middle East, Africa, and Asia-
Pacific Countries/Regions)

Stapler/stacker with hole punch finishing accessory A2W82A

HP LaserJet Booklet Maker/Finisher (available in Europe, 
the Middle East, Africa, and Asia-Pacific Countries/
Regions)

Booklet maker finishing accessory A2W83A

HP LaserJet Booklet Maker/Finisher with 2/3 hole punch 
(available in North America and Latin America)

Booklet maker with hole punch finishing accessory A2W84A

HP LaserJet Booklet Maker/Finisher with 2/4 hole punch 
(available in Europe, the Middle East, Africa, and Asia-
Pacific Countries/Regions)

Booklet maker with hole punch finishing accessory CZ999A

HP Jetdirect ew2500 Wireless Print Server USB wireless print server J8026A

HP Jetdirect 2800w NFC & Wireless Direct Accessory Wireless direct accessory for “touch” printing from mobile 
devices

J8029A
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Replace the toner cartridges
The product uses four colors and has a different toner cartridge for each color: black (K), cyan (C), magenta 
(M), and yellow (Y). The product also has four imaging drums that are separate from the toner cartridges. The 
toner cartridges are above the imaging drums. The toner cartridges and imaging drums are inside the front 
door. A toner cartridge and its associated imaging drum are replaced independently of each other.

This product indicates when the toner cartrdige level is low. The actual toner cartridge life remaining can vary. 
The toner cartridge does not need to be replaced at this time. Consider having a replacement cartridge 
available to install when print quality is no longer acceptable.

The following illustration shows the toner-cartridge components.

1

2

1 Toner-cartridge handle

2 Memory chip

CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold water. Hot 
water sets toner into fabric.

NOTE: Information about recycling used toner cartridges is on the toner cartridge box.
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1. Open the front door.  

2. Grasp the handle of the used toner cartridge and 
pull out to remove it.

 

3. Remove the new toner cartridge from its 
protective bag.
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4. Hold both sides of the toner cartridge and shake 
it up and down 5-6 times.

 

5. Align the toner cartridge with its slot, and then 
insert the toner cartridge into the product.

 

6. Close the front door.  
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Replace the imaging drums
The product uses four colors and has a different imaging drum for each color: black (K), cyan (C), magenta (M), 
and yellow (Y). The product also has four toner cartridges that are separate from the imaging drums. The 
toner cartridges are above the imaging drums. The toner cartridges and imaging drums are inside the front 
door. A toner cartridge and its associated imaging drum are replaced independently of each other.

This product indicates when the imaging drum life is low. The actual imaging drum life remaining can vary. 
The imaging drum does not need to be replaced at this time. Consider having a replacement imaging drum 
available to install when print quality is no longer acceptable.

The following illustration shows the imaging-drum components.

1

3

2

1 Imaging-drum handles

2 Memory chip

3 Photosensitive drum

CAUTION: Do not touch the photosensitive drum. Fingerprints on the drum can cause print defects.

CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold water. Hot 
water sets toner into fabric.

NOTE: Information about recycling used imaging drums is on the imaging-drum box.
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1. Open the front door.  

2. Grasp the handle of the used imaging drum and 
pull out to remove it. Grasp the blue handle on 
the top of the imaging drum to support it.

 

3. Remove the new imaging drum from its 
protective bag.
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4. Align the imaging drum with its slot, and then 
insert the imaging drum into the product. The 
protective cover on the bottom of the drum 
automatically slides off as the imaging drum is 
inserted. Recycle this cover with the used imaging 
drum.

 

5. Close the front door.  
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4 Print

● Print tasks (Windows)

● Print tasks (Mac OS X)

● Store print jobs on the product

● Mobile printing

● Print from the USB port

For more information:

In the US, go to www.hp.com/support/colorljM855.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Print tasks (Windows)

How to print (Windows)

The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then select Properties or Preferences (the name varies 
for different software programs).

3. Click or tap the tabs in the print driver to configure the available options.

4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from 
this screen.

5. Click or tap the OK button to print the job.
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Automatically print on both sides (Windows)

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box. Click 
the OK button to close the Document Properties 
dialog box.

 

5. In the Print dialog box, click the OK button to 
print the job.
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Manually print on both sides (Windows) 

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box. Click 
the OK button to print the first side of the job.

 

5. Retrieve the printed stack from the output bin, 
and then place it with the printed-side facing up 
in Tray 1.

 

6. If prompted, touch the appropriate control panel 
button to continue.
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Print multiple pages per sheet (Windows)

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the 
Pages per sheet drop-down list.

 

5. Select the correct Print page borders, Page 
order, and Orientation options. Click the OK 
button to close the Document Properties dialog 
box.

 

6. In the Print dialog box, click the OK button to 
print the job.
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Select the paper type (Windows)

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Paper/Quality tab.  
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4. From the Paper type drop-down list, click the 
More... option.

 

5. Expand the list of Type is: options.  

6. Expand the category of paper types that best 
describes your paper.
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7. Select the option for the type of paper you are 
using, and then click the OK button.

 

8. Click the OK button to close the Document 
Properties dialog box. In the Print dialog box, 
click the OK button to print the job.
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Print tasks (Mac OS X)

How to print (Mac OS X)

The following procedure describes the basic printing process for Mac OS X.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then select other menus to adjust the print 
settings.

4. Click the Print button.

Automatically print on both sides (Mac OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using 
AirPrint.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (Mac OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using 
AirPrint.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select this product.

3. Open the menus drop-down list or click Show Details, and then click the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input 
tray.

8. If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

52 Chapter 4   Print ENWW



3. Open the menus drop-down list or click Show Details, and then click the Layout menu.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each 
sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the paper type (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.
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Store print jobs on the product

Create a stored job (Windows)

You can store jobs on the product so you can print them at any time.

NOTE: Your print driver might look different than what is shown here, but the steps are the same.

1. From the software program, select the Print 
option.

 

2. Select the product from the list of printers, and 
then select Properties or Preferences (the name 
varies for different software programs).

 

3. Click the Job Storage tab.  
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4. Select a Job Storage Mode option.

● Proof and Hold: Print and proof one copy of a 
job, and then print more copies.

● Personal Job: The job does not print until 
you request it at the product control panel. 
For this job-storage mode, you can select 
one of the Make Job Private/Secure options. 
If you assign a personal identification 
number (PIN) to the job, you must provide 
the required PIN at the control panel. If you 
encrypt the job, you must provide the 
required password at the control panel.

● Quick Copy: Print the requested number of 
copies of a job and store a copy of the job in 
the product memory so you can print it again 
later.

● Stored Job: Store a job on the product and 
allow other users to print the job at any time. 
For this job-storage mode, you can select 
one of the Make Job Private/Secure options. 
If you assign a personal identification 
number (PIN) to the job, the person who 
prints the job must provide the required PIN 
at the control panel. If you encrypt the job, 
the person who prints the job must provide 
the required password at the control panel.
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5. To use a custom user name or job name, click the 
Custom button, and then enter the user name or 
the job name.

Select which option to use if another stored job 
already has that name:

● Use Job Name + (1-99): Append a unique 
number to the end of the job name.

● Replace Existing File: Overwrite the existing 
stored job with the new one.

 

6. Click the OK button to close the Document 
Properties dialog box. In the Print dialog box, 
click the OK button to print the job.

 

Create a stored job (Mac OS X)

You can store jobs on the product so you can print them at any time.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then 
click the Job Storage menu.

4. In the Mode drop-down list, select the type of stored job.

● Proof and Hold: Print and proof one copy of a job, and then print more copies.

● Personal Job: The job does not print until you request it at the product control panel. If you assign 
a personal identification number (PIN) to the job, you must provide the required PIN at the control 
panel.
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● Quick Copy: Print the requested number of copies of a job and store a copy of the job in the product 
memory so you can print it again later.

● Stored Job: Store a job on the product and allow other users to print the job at any time. If you 
assign a personal identification number (PIN) to the job, the person who prints the job must 
provide the required PIN at the control panel.

5. To use a custom user name or job name, click the Custom button, and then enter the user name or the 
job name.

Select which option to use if another stored job already has that name.

● Use Job Name + (1-99): Append a unique number to the end of the job name.

● Replace Existing File: Overwrite the existing stored job with the new one.

6. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a PIN. Type 
a 4-digit number in the Use PIN to Print field. When other people attempt to print this job, the product 
prompts them to enter this PIN number.

7. Click the Print button to process the job.

Print a stored job

Use the following procedure to print a job that is stored in the product memory.

1. From the Home screen on the product control panel, scroll to and touch the Retrieve from Device 
Memory button.

2. Select the name of the folder where the job is stored.

3. Select the name of the job. If the job is private or encrypted, enter the PIN or password.

4. Adjust the number of copies, and then touch the Start  button to print the job.

Delete a stored job

When you send a stored job to the product memory, the product overwrites any previous jobs with the same 
user and job name. If a job is not already stored under the same user and job name, and the product needs 
additional space, the product might delete other stored jobs starting with the oldest. You can change the 
number of jobs that the product can store from the General Settings menu on the product control panel.

Use this procedure to delete a job that is stored in the product memory.

1. From the Home screen on the product control panel, scroll to and touch the Retrieve from Device 
Memory button.

2. Select the name of the folder where the job is stored.

3. Select the name of the job, and then touch the Delete button.

4. If the job is private or encrypted, enter the PIN or the password, and then touch the Delete button.
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Mobile printing
HP offers multiple Mobile and ePrint solutions to enable wireless printing to an HP printer from a laptop, 
tablet, smartphone, or other mobile device. To determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting (English only).

HP Wireless Direct printing

HP provides HP Wireless Direct and NFC (Near Field Communication) printing for printers with the HP Jetdirect 
2800w NFC & Wireless Direct Accessory (part number: J8029-90901) as well as certain other HP LaserJet 
printers (check the printer’s documentation). See www.hp.com/go/jd2800wSupport for more information on 
the HP Jetdirect 2800w NFC & Wireless Direct Accessory.

HP Wireless Direct printing enables printing from a wireless mobile device directly to an HP Wireless Direct-
enabled printer without requiring a connection to a network or the Internet.

Use HP Wireless Direct to print wirelessly from the following devices:

● iPhone, iPad, or iPod touch using Apple AirPrint or the HP ePrint App

● Android mobile devices using the HP ePrint App or the Android embedded print solution

● Symbian mobile devices using the HP ePrint Home & Biz App

● PC and Mac devices using the HP ePrint Software

For more information on HP Wireless Direct printing, go to www.hp.com/go/wirelessprinting and click HP 
wireless direct on the left navigation bar.

HP ePrint via email

Use HP ePrint to print documents by sending them as an email attachment to the product's email address 
from any email enabled device.

NOTE: The product might require a firmware update to use this feature.

To use HP ePrint, the product must meet these requirements:

● The product must be connected to a wired or wireless network and have Internet access.

● HP Web Services must be enabled on the product, and the product must be registered with 
HP Connected.

Follow this procedure to enable HP Web Services and register with HP Connected:

1. Open the HP Embedded Web Server (EWS):

a. From the Home screen on the product control panel, touch the Network  button to display the IP 
address or host name.

b. Open a Web browser, and in the address line, type the IP address or host name exactly as it 
displays on the product control panel. Press the Enter key on the computer keyboard. The EWS 
opens.

2. Click the HP Web Services tab.
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3. Select the option to enable Web Services.

NOTE: Enabling Web Services might take several minutes.

4. Go to www.hpconnected.com to create an HP ePrint account and complete the setup process.

HP ePrint software

The HP ePrint software makes it easy to print from a Windows or Mac desktop or laptop computer to any HP 
ePrint-capable product. This software makes it easy to find HP ePrint-enabled products that are registered to 
your HP Connected account. The target HP printer can be located in the office or at locations across the globe.

● Windows: After installing the software, open the Print option from within your application, and then 
select HP ePrint from the installed printers list. Click the Properties button to configure print options.

● Mac: After installing the software, select File, Print, and then select the arrow next to PDF (in the 
bottom left of the driver screen). Select HP ePrint.

For Windows, the HP ePrint software supports TCP/IP printing to local network printers on the network (LAN 
or WAN) to products that support UPD PostScript®.

Windows and Mac both support IPP printing to LAN or WAN network-connected products that support ePCL.

Windows and Mac also both support printing PDF documents to public print locations and printing using HP 
ePrint via email through the cloud.

Go to www.hp.com/go/eprintsoftware for drivers and information.

NOTE: The HP ePrint software is a PDF workflow utility for Mac, and is not technically a print driver.

NOTE: HP ePrint Software does not support USB printing.
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AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the 
product from an iPad, iPhone (3GS or later), or iPod touch (third generation or later) in the following 
applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the product must be connected to the same wireless network as the Apple device. For more 
information about using AirPrint and about which HP products are compatible with AirPrint, go to 
www.hp.com/go/airprint.

NOTE: AirPrint does not support USB connections.
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Print from the USB port
This product features easy-access USB printing, so you can quickly print files without sending them from a 
computer. The product accepts standard USB flash drives in the USB port on the front of the product. You can 
print the following types of files:

● .pdf

● .prn

● .pcl

● .ps

● .cht

Enable the USB port for printing

Before you can use this feature, you must enable the USB port. Use the following procedure to enable the port 
from the product control-panel menus:

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Enable Retrieve from USB

3. Select the Enable option, and then touch the Save button.

Print USB documents

1. Insert the USB flash drive into the easy-access USB port.

NOTE: You might need to remove the cover from the USB port. Pull the cover straight out to remove it.

2. The product detects the USB flash drive. Touch the OK button to access the drive, or, if prompted, select 
the Retrieve from USB option from the list of available applications. The Retrieve from USB screen 
opens.

3. Select the name of the document that you want to print.

NOTE: The document might be in a folder. Open folders as necessary.

4. To adjust the number of copies, touch the Copies field, and then use the keypad to select the number of 
copies.

5. Touch the Start  button to print the document.
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5 Manage the product

● HP Embedded Web Server

● HP Utility for Mac OS X

● HP Web Jetadmin

● Economy settings

● Product security features

● Software and firmware updates

For more information:

In the US, go to www.hp.com/support/colorljM855.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information

ENWW 63

http://www.hp.com/support/colorljM855
http://www.hp.com/support


HP Embedded Web Server
Use the HP Embedded Web Server to manage printing functions from your computer instead of the product 
control panel.

● View product status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the product control-panel menu configuration

● View and print internal pages

● Receive notification of product and supplies events

● View and change network configuration

The HP Embedded Web Server works when the product is connected to an IP-based network. The 
HP Embedded Web Server does not support IPX-based product connections. You do not have to have Internet 
access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

How to access the HP Embedded Web Server (EWS)

1. From the Home screen on the product control panel, touch the Network  button to display the IP 
address or host name.

2. Open a Web browser, and in the address line, type the IP address or host name exactly as it displays on 
the product control panel. Press the Enter key on the computer keyboard. The EWS opens.

To use the HP Embedded Web Server, your browser must meet the following requirements:

● Windows: Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later

● Mac OS X: Safari or Firefox using Bonjour or an IP address

● Linux: Netscape Navigator only

● HP-UX 10 and HP-UX 11: Netscape Navigator 4.7
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to check product status or to view or change product settings from your 
computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based 
network.

Open HP Utility

From the Finder, click Applications, click HP, and then click HP Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1. At the computer, open the Apple  menu, click the System Preferences menu, and then click the Print 
& Fax icon or the Print & Scan icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features

The HP Utility toolbar is at the top of every page. It includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility in the Printers pane at 
the left side of the screen.

● All Settings: Click this button to return to the HP Utility main page.

● Applications: Click this button to manage which HP tools or utilities appear in the Dock.

● HP Support: Click this button to open a browser and go to the HP support Web site for the product.

● Supplies: Click this button to open the HP SureSupply Web site.

● Registration: Click this button to open the HP registration Web site.

● Recycling: Click this button to open the HP Planet Partners Recycling Program Web site.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the 
tasks that you can perform with HP Utility.

Menu Item Description

Information and Support Supplies Status Shows the product supplies status and provides links for ordering 
supplies online.

 Device Information Shows information about the currently selected product.

 File Upload Transfers files from the computer to the product.

 Upload Fonts Transfers font files from the computer to the product.

 HP Connected Accesses the HP Connected Web site.
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Menu Item Description

 Update Firmware Transfers a firmware update file to the product.

NOTE: This option is available only after you open the View menu and 
select the Show Advanced Options item.

 Commands Sends special characters or print commands to the product after the print 
job.

NOTE: This option is available only after you open the View menu and 
select the Show Advanced Options item.

Printer Settings Supplies Management Configures how the product should behave when supplies are nearing the 
end of their estimated life.

 Trays Configuration Changes the default tray settings.

 Output Devices Manages settings for optional output accessories.

 Duplex Mode Turns on the automatic two-sided printing mode.

 Protect Direct Ports Disables printing over USB or parallel ports.

 Stored Jobs Manages print jobs that are stored on the product hard disk.

 Network Settings Configures the network settings, such as the IPv4 and IPv6 settings.

 Additional Settings Provides access to the HP Embedded Web Server.
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HP Web Jetadmin
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of 
networked HP products, including printers, multifunction products, and digital senders. This single solution 
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging 
environment — ultimately increasing business productivity by helping you save time, control costs, and 
protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features. 
Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about 
upgrades.
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Economy settings
● Optimize speed or energy usage

● Set Sleep mode

● Set the Sleep Schedule

Optimize speed or energy usage

By default the product stays warm between jobs to optimize speed and print the first page of jobs faster. To 
conserve energy, set the product to cool between jobs. The product has four incremental settings to optimize 
for speed or energy usage.

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Energy Settings

● Optimum Speed/Energy Usage

3. Select the option that you want to use, and then touch the Save button.

Set Sleep mode

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Energy Settings

● Sleep Timer Settings

3. Touch Sleep/Auto Off After to select the option.

4. Select the appropriate time period, and then touch the Save button.

Set the Sleep Schedule

NOTE: You must configure the date and time settings before you can use the Sleep Schedule feature.

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Date/Time Settings

3. Open the Date/Time Format menu and configure the following settings:

● Date Format

● Time Format
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4. Touch the Save button.

5. Open the Date/Time menu and configure the following settings:

● Date/Time

● Time Zone

If you are in an area that uses daylight savings time, select the Adjust for Daylight Savings box.

6. Touch the Save button.

7. Touch the back-arrow button to return to the Administration screen.

8. Open the following menus:

● General Settings

● Energy Settings

● Sleep Schedule

9. Touch the Add  button, and then select the type of event to schedule: Wake or Sleep.

10. Configure the following settings:

● Time

● Event Days

11. Touch the OK button, and then touch the Save button.
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Product security features
● Security statements

● IP Security

● Sign in to the product

● Assign a system password

● Encryption support: HP High Performance Secure Hard Disks

Security statements

The product supports security standards and recommended protocols that help you keep the product secure, 
protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

IP Security

IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product. IPsec 
provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure IPsec 
by using the Networking tab in the HP Embedded Web Server.

Sign in to the product

Some features on the product control panel can be secured so that unauthorized people cannot use them. 
When a feature is secured, the product prompts you to sign in before you can use it. You can also sign in 
without waiting for a prompt by touching the Sign In button on the Home screen.

Typically, you use the same user name and password that you use to sign in to your computer on the network. 
Consult the network administrator for this product if you have questions about which credentials to use.

After you have signed in to the product, a Sign Out button displays on the control panel. To maintain security 
for the product, touch the Sign Out button when you have finished using the product.

Assign a system password

Assign an administrator password for access to the product and the HP Embedded Web Server so that 
unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web 
browser.

2. Click the Security tab.

3. Open the General Security menu.

4. In the Username field, enter the name to associate with the password.

5. Enter the password in the New Password field, and then enter it again in the Verify Password field.
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NOTE: If you are changing an existing password, you must first enter the existing password in the Old 
Password field.

6. Click the Apply button. Make note of the password and store it in a safe place.

Encryption support: HP High Performance Secure Hard Disks

The hard disk provides hardware-based encryption so you can securely store sensitive data without impacting 
product performance. This hard disk uses the latest Advanced Encryption Standard (AES) and has versatile 
time-saving features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.
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Software and firmware updates
HP regularly updates features that are available in the product firmware. To take advantage of the most 
current features, update the product firmware. Download the most recent firmware update file from the Web:

In the US, go to www.hp.com/support/colorljM855. Click Drivers & Software.

Outside the US, follow these steps:

1. Go to www.hp.com/support.

2. Select your country/region.

3. Click Drivers & Software.

4. Enter the product name (HP Color LaserJet Enterprise M855), and then select Search.
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6 Solve problems

● Restore factory-set defaults

● Control panel help system

● A “Cartridge is low” or “Cartridge is very low” message displays on the product control panel

● Product does not pick up paper or misfeeds

● Clear jams

● Improve print quality

● Solve wired network problems

For more information:

In the US, go to www.hp.com/support/colorljM855.

Outside the US, go to www.hp.com/support. Select your country/region. Click Product Support & 
Troubleshooting. Enter the product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Restore factory-set defaults
1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Restore Factory Settings

3. A verification message advises that completing the reset function might result in loss of data. Touch the 
Reset button to complete the process.

NOTE: The product restarts automatically after the reset operation completes.
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Control panel help system
The product has a built-in Help system that explains how to use each screen. To open the Help system, touch 
the Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse 
through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for 
that screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that describes 
the problem. The message also contains instructions to help solve the problem.
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A “Cartridge is low” or “Cartridge is very low” message displays 
on the product control panel

Cartridge is low: The product indicates when a toner cartridge level is low. Actual toner cartridge life 
remaining may vary. Consider having a replacement available to install when print quality is no longer 
acceptable. The toner cartridge does not need to be replaced now.

Cartridge is very low: The product indicates when the toner cartridge level is very low. Actual toner cartridge 
life remaining may vary. Consider having a replacement available to install when print quality is no longer 
acceptable. The toner cartridge does not need to be replaced now unless the print quality is no longer 
acceptable.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner cartridge 
has ended.

Change the “Very Low” settings

You can change the way the product reacts when supplies reach the Very Low state. You do not have to re-
establish these settings when you install a new toner cartridge.

1. From the Home screen on the product control panel, scroll to and touch Supplies.

2. Open the following menus:

● Manage Supplies

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Settings

3. Select one of the following options:

● Select the Stop option to set the product to stop printing when the cartridge reaches the Very Low 
threshold.

● Select the Prompt to continue option to set the product to stop printing when the cartridge reaches 
the Very Low threshold. You can acknowledge the prompt or replace the cartridge to resume 
printing.

● Select the Continue option to set the product to alert you that the cartridge is very low, and to 
continue printing beyond the Very Low setting without interaction. This can result in 
unsatisfactory print quality.

For products with fax capability

When the product is set to the Stop or Prompt to continue option, there is some risk that faxes will not print 
when the product resumes printing. This can occur if the product has received more faxes than the memory 
can hold while the product is waiting.

The product can print faxes without interruption when it passes the Very Low threshold if you select the 
Continue option for the toner cartridge, but print quality might degrade.
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Order supplies

Order supplies and paper www.hp.com/go/suresupply

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter 
the product IP address or host name in the address/URL field. The 
EWS contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.
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Product does not pick up paper or misfeeds
● The product does not pick up paper

● The product picks up multiple sheets of paper

● The document feeder jams, skews, or picks up multiple sheets of paper

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to 
the appropriate indentation in the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed 
the paper manually. Load paper, and continue.

6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with 
warm water.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to 
the appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.

The document feeder jams, skews, or picks up multiple sheets of paper

NOTE: This information applies to MFP products only.

● The original might have something on it, such as staples or self-adhesive notes, that must be removed.

● Check that all rollers are in place and that the roller-access cover inside the document feeder is closed.

● Make sure that the top document-feeder cover is closed.

● The pages might not be placed correctly. Straighten the pages and adjust the paper guides to center the 
stack.
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● The paper guides must be touching the sides of the paper stack to work correctly. Make sure that the 
paper stack is straight and the guides are against the paper stack.

● The document feeder input tray or output bin might contain more than the maximum number of pages. 
Make sure the paper stack fits below the guides in the input tray, and remove pages from the output bin.

● Verify that there are no pieces of paper, staples, paper clips, or other debris in the paper path.

● Clean the document-feeder rollers and the separation pad. Use compressed air or a clean, lint-free cloth 
moistened with warm water. If misfeeds still occur, replace the rollers.

● From the Home screen on the product control panel, scroll to and touch the Supplies button. Check the 
status of the document-feeder kit, and replace it if necessary.
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Clear jams

Auto-navigation for clearing jams

The auto-navigation feature assists you in clearing jams by providing step-by-step instructions on the control 
panel. When you complete a step, the product displays instructions for the next step until you have 
completed all steps in the procedure.

Experiencing frequent or recurring paper jams?

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so 
they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed 
sheets one at a time.

8. From the Home screen on the product control panel, scroll to and touch the Trays button. Verify that the 
tray is configured correctly for the paper type and size.

9. Make sure the printing environment is within recommended specifications.
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Clear jams in Tray 1, the right door, and the fuser

Clear jams in Tray 1, the right door, and the fuser by opening the right door of the product. Use the following 
procedure to check for paper in all possible jam locations inside the right door. When a jam occurs, the control 
panel displays an animation that assists in clearing the jam.

1. Open the right door.  

2. If paper is jammed in Tray 1, gently pull the paper 
from the bottom of the right door.
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3. Check for paper in the duplex-printing path inside 
the right door. If paper is near the top of the 
duplex-printing path, gently pull it out to remove 
it.

 

4. Lift the jam-access cover at the bottom of the 
duplex printing path, and remove any jammed 
paper.

 

5. Lift the green handle on the transfer-access panel 
and open the panel.
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6. Gently pull out any jammed paper.  

7. Close the transfer-access panel.  
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8. If paper is jammed in the fuser, lift the jam-
access cover on top of the fuser, and gently pull 
out the paper.

WARNING! The fuser can be hot while the 
product is in use.

 

9. Close the right door.  
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Clear jams in Tray 2

Use the following procedure to check for paper in all possible jam locations related to Tray 2. When a jam 
occurs, the control panel displays an animation that assists in clearing the jam.

1. Open the right door.  

2. Lift the green handle on the transfer-access panel 
and open the panel.

 

3. Gently pull out any jammed paper.  
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4. Close the transfer-access panel.  

5. Close the right door.  

6. Pull the tray completely out of the product by 
pulling and lifting it up slightly.
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7. Remove any jammed or damaged sheets of 
paper.

 

8. Remove any paper from the feed rollers inside 
the product.

 

9. Reinsert and close the tray.  
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Clear jams in the 3x500-sheet feeder and the lower-right door

Use the following procedure to check for paper in all possible jam locations related to the 3x500-sheet feeder. 
When a jam occurs, the control panel displays an animation that assists in clearing the jam.

1. Open the lower-right door.  

2. Gently pull out any jammed paper.  

3. Close the lower-right door.  
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4. Open the tray.

NOTE: The message on the product control 
panel indicates which tray has the jam. The 
following steps show removing a jam from the 
top tray, but the procedure is the same for all 
three trays.

 

5. Remove any jammed or damaged sheets of 
paper.

 

6. Close the tray.  
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Clear jams in the 3,500-sheet high-capacity input tray and the lower-right door

Use the following procedure to check for paper in all possible jam locations related to the 3,500-sheet high-
capacity tray. When a jam occurs, the control panel displays an animation that assists in clearing the jam.

1. Open the right and left trays.

NOTE: You do not need to open both trays at 
the same time.

 

2. Remove the paper from the trays and discard any 
damaged sheets.

 

3. Above the right-side tray, press the green button 
to release the jam-access plate.
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4. If jammed paper is in the feed area, pull it down 
to remove it.

 

5. Push up on the jam-access plate to close it.  

6. Load full reams of paper into each side of the 
tray. The right side holds 1,500 sheets of paper. 
The left side holds 2,000 sheets of paper.

NOTE: For best results, load full reams of paper. 
Avoid dividing reams into smaller sections.
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7. Close the right and left trays.  

8. Open the jam-access door on the right side of the 
high-capacity tray cabinet.
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9. Remove any jammed paper.  

10. Close the jam-access door on the right side of the 
high-capacity tray cabinet.

NOTE: If after clearing the jam the product 
control panel displays a message that there is no 
paper in the tray or the tray is over filled, remove 
the tray and look behind it for any remaining 
paper.

 

Clear output jams in the output-accessory bridge

The output-accessory bridge is installed on products with an optional finishing accessory. The output-
accessory bridge transfers paper from the output slot near the control panel, across the top of the product, 
and into the finishing accessory. Use the following procedure to clear jams in this area.
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1. Lift the latch on the top cover of the output-
accessory bridge and open the top cover.

 

2. Gently pull the jammed paper to remove it.  

3. Close the top cover of the output-accessory 
bridge.
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Clear jams in the stapler/stacker accessory or the stapler/stacker with hole punch 
accessory

The procedures to clear paper jams and staple jams in the stapler/stacker accessory and the stapler/stacker 
with hole punch accessory are similar. Use the following procedures to check for jams in all possible locations 
inside the finishing accessory. When a jam occurs, the control panel displays an animation that assists in 
clearing the jam. Only the stapler/stacker with hole punch accessory is shown in the following tasks. Steps 
that apply only to the hole-punch model are clearly indicated.

● Clear top left door jams in the stapler/stacker

● Clear Stapler 1 jams in the stapler/stacker

● Clear stapler/stacker connection jams (hole-punch models only)

Clear top left door jams in the stapler/stacker

1. Open the top left door.  

2. Hole punch models only: Open the hole-punch 
door.
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3. Hole punch models only: Turn the knob to align 
the arrows.

 

4. Hole punch models only: Lift the hole-punch 
unit.

 

5. Hole punch models only: If paper is jammed in 
the bottom of the hole-punch unit, carefully 
remove it.

NOTE: Do not close the hole-punch unit yet.
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6. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.

 

7. Remove all paper from the top left door area.  

8. Hole punch models only: Close the hole-punch 
unit.

NOTE: Ensure the arrows on the hole punch are 
positioned as shown in the graphic.
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9. Hole punch models only: Close the hole-punch 
door.

 

10. Close the top left door.  

Clear Stapler 1 jams in the stapler/stacker

1. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.
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2. Wait three seconds, and then open the front left 
door.

 

3. Pull the staple cartridge up and out to remove it.  

4. Lift up the metal handle on the front of the staple 
cartridge.
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5. Remove any jammed staples from the staple 
cartridge.

 

6. Push down the metal handle on the front of the 
staple cartridge.
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7. Insert the staple cartridge. Press down on the top 
of the staple cartridge until it clicks into place.

 

8. Close the front left door.  

Clear stapler/stacker connection jams (hole-punch models only)

1. Open the top left door.  
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2. Open the hole-punch door.  

3. Turn the knob to align the arrows.  

4. Lift the hole-punch unit.  
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5. If paper is jammed in the bottom of the hole-
punch unit, carefully remove it.

NOTE: Do not close the hole-punch unit yet.

 

6. Remove all paper from the top left door area.  

7. Close the hole-punch unit.

NOTE: Ensure the arrows on the hole punch are 
positioned as shown in the graphic.
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8. Close the hole-punch door.  

9. Close the top left door.  
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Clear jams in the booklet maker accessory or the booklet maker with hole punch 
accessory

The procedures to clear paper jams and staple jams in the booklet maker accessory and the booklet maker 
with hole punch accessory are similar. Use the following procedures to check for jams in all possible locations 
inside the finishing accessory. When a jam occurs, the control panel displays an animation that assists in 
clearing the jam. Only the booklet maker with hole punch accessory is shown in the following tasks. Steps that 
apply only to the hole-punch model are clearly indicated.

● Clear top left door jams in the booklet maker

● Clear Stapler 1 jams in the booklet maker

● Clear front left door jams in the booklet maker

● Clear stapler 2 or 3 jams in the booklet maker

Clear top left door jams in the booklet maker

1. Open the top left door.  

2. Hole punch models only: Open the hole-punch 
door.
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3. Hole punch models only: Turn the knob to align 
the arrows.

 

4. Hole punch models only: Lift the hole-punch 
unit.

 

5. Hole punch models only: If paper is jammed in 
the bottom of the hole-punch unit, carefully 
remove it.

NOTE: Do not close the hole-punch unit yet.
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6. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.

 

7. Remove all paper from the top left door area.  

8. Hole punch models only: Close the hole-punch 
unit.

NOTE: Ensure the arrows on the hole punch are 
positioned as shown in the graphic.
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9. Hole punch models only: Close the hole-punch 
door.

 

10. Close the top left door.  

Clear Stapler 1 jams in the booklet maker

1. Lift the jam access cover for the output slot, and 
gently remove any jammed paper.

 

108 Chapter 6   Solve problems ENWW



2. Wait three seconds, and then open the front left 
door.

 

3. Pull the staple cartridge up and out to remove it.  

4. Lift up the metal handle on the front of the staple 
cartridge.
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5. Remove any jammed staples from the staple 
cartridge.

 

6. Push down the metal handle on the front of the 
staple cartridge.
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7. Insert the staple cartridge. Press down on the top 
of the staple cartridge until it clicks into place.

 

8. Close the front left door.  

Clear front left door jams in the booklet maker

1. Open the front left door.  
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2. Hole punch models only: Open the top left door.  

3. Hole punch models only: Open the hole-punch 
door.

 

4. Hole punch models only: Turn the knob to align 
the arrows.
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5. Hole punch models only: Lift the hole-punch 
unit.

 

6. Hole punch models only: If paper is jammed in 
the bottom of the hole-punch unit, carefully 
remove it.

 

7. Hole punch models only: Close the hole-punch 
unit.

NOTE: Ensure the arrows on the hole punch are 
positioned as shown in the graphic.
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8. Hole punch models only: Close the hole-punch 
door.

 

9. Hole punch models only: Close the top left door.  

10. Move the lower jam-release lever to the right, and 
then remove any paper. Move the lower jam-
release handle to the left.
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11. Move the upper jam-release lever to the right, 
and then remove any paper. Move the upper jam-
release handle to the left.

 

12. Open the lower booklet door.  

13. Turn the small jam-release knob 
counterclockwise.
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14. Press the large jam-release knob, and then turn it 
clockwise.

 

15. Remove all paper from the lower booklet door 
area.
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16. Close the lower booklet door.  

17. Close the front left door.  

Clear stapler 2 or 3 jams in the booklet maker

1. Open the front left door.  
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2. Move the lower jam-release lever to the right, and 
then remove any paper. Move the lower jam-
release handle to the left.

 

3. Grasp the green handle and pull the staple 
carriage out.

 

4. Pull the green handle of the stapler unit toward 
you and rotate it upward. Push the handle in to 
lock it in the open position.

 

1

2
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5. Grasp the edges of each staple cartridge and 
firmly pull up to remove the staple cartridges 
from the staple cartridge unit.

 

6. Press down on the jam-release at the back of the 
saddle-staple cartridge, push up on the plate at 
the front of the cartridge, and then remove any 
jammed staples.

 

1

2
3

7. Press down on the front of the saddle-staple 
cartridge close it.
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8. Insert the staple cartridges.  

9. Pull the handle of the staple cartridge unit toward 
you and rotate it downward to its original 
position. Lock it into position by pushing in the 
handle.

 

1

2
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10. Push the saddle-stitch carriage in.

NOTE: If the saddle-stitch carriage does not 
easily slide into the finisher, the staple unit is not 
closed properly. Pull the saddle-stitch carriage 
out of the finisher and reseat the stapler unit.

 

11. Close the front left door.  

ENWW Clear jams 121



Improve print quality
If the product is having print-quality problems, try the following solutions in the order presented to resolve 
the issue.

● Print from a different software program

● Check the paper-type setting for the print job

● Check toner-cartridge status

● Calibrate the product to align the colors

● Print a cleaning page

● Visually inspect the imaging-drum

● Check paper and the printing environment

● Check other print job settings

● Try a different print driver

● Set the individual tray alignment

Print from a different software program

Try printing from a different software program. If the page prints correctly, the problem is with the software 
program from which you were printing.

Check the paper-type setting for the print job

Check the paper type setting when printing from a software program and the printed pages have smears, 
fuzzy or dark print, curled paper, scattered dots of toner, loose toner, or small areas of missing toner.

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK 
button to print the job.

Check the paper type setting (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.
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3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then 
click the Finishing menu.

4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Check toner-cartridge status

Follow these steps to check the estimated life remaining in the toner cartridges and if applicable, the status 
of other replaceable maintenance parts.

Step one: Print the supplies status page

1. From the Home screen on the product control panel, scroll to and touch the Supplies button.

2. The status of all supply items is listed on the screen.

3. To print or view a report of the status of all supply items, including the genuine HP part number for 
reordering the supply, touch the Manage Supplies button. Touch the Supplies Status button, and then 
touch either the Print or View button.

Step two: Check supplies status

1. Look at the supplies status report to check the percent of life remaining for the toner cartridges and if 
applicable, the status of other replaceable maintenance parts.

Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The 
supplies status page indicates when a supply level is very low. After an HP supply has reached the very 
low threshold, HP’s premium protection warranty on that supply has ended.

The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable. 
Consider having a replacement available to install when print quality is no longer acceptable.

If you determine that you need to replace a toner cartridge or other replaceable maintenance parts, the 
supplies status page lists the genuine HP part numbers.

2. Check to see if you are using a genuine HP cartridge.

A genuine HP toner cartridge has the words “HP” on it, or has the HP logo on it. For more information on 
identifying HP cartridges go to www.hp.com/go/learnaboutsupplies.

Calibrate the product to align the colors

Calibration is a product function that optimizes print quality.

Follow these steps to resolve print print-quality problems such as misaligned color, colored shadows, blurry 
graphics, or other print-quality issues.

1. From the Home screen on the product control panel, scroll to and touch the Device Maintenance button.

2. Open the following menus:

● Calibration/Cleaning

● Full Calibration
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3. Touch the Start button to start the calibration process.

A Calibrating message will display on the product control panel. The calibration process takes a few 
minutes to complete. Do not turn the product off until the calibration process has finished.

4. Wait while the product calibrates, and then try printing again.

Print a cleaning page

During the printing process paper, toner, and dust particles can accumulate inside the product and can cause 
print-quality issues such as toner specks or spatter, smears, streaks, lines, or repeating marks.

Follow these steps to clean the product's paper path.

1. From the Home screen on the product control panel, scroll to and touch the Device Maintenance button.

2. Touch Calibration/Cleaning, touch Cleaning Page, and then touch Print to print the page.

A Cleaning message displays on the product control panel. The cleaning process takes a few minutes to 
complete. Do not turn the product off until the cleaning process has finished. When it is finished, discard 
the printed page.

Visually inspect the imaging-drum

Follow these steps to inspect each imaging drum.

1. Remove the imaging drum from the product.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum.

CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality 
problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace it.

5. Reinstall the imaging drum, and print a few pages to see if the problem has resolved.

Check paper and the printing environment

Step one: Use paper that meets HP specifications

Some print-quality problems arise from using paper that does not meet HP specifications.

● Always use a paper type and weight that this product supports.

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, 
voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that does not contain metallic material, such as glitter.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in 
Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Step two: Check the environment

The environment can directly affect print quality and is a common cause for print-quality or paper-feeding 
issues. Try the following solutions:

● Move the product away from drafty locations, such as open windows or doors, or air-conditioning vents.

● Make sure the product is not exposed to temperatures or humidity outside of product specifications.

● Do not place the product in a confined space, such as a cabinet.

● Place the product on a sturdy, level surface.

● Remove anything that is blocking the vents on the product. The product requires good air flow on all 
sides, including the top.

● Protect the product from airborne debris, dust, steam, grease, or other elements that can leave residue 
inside the product.

Check other print job settings

When printing from a software program, follow these steps to try to resolve the issue by adjusting other 
print-driver settings.

Adjust color settings (Windows)

Follow these steps if colors on the printed page to not match colors on the computer screen, or if the colors 
on the printed page are not satisfactory.

Change the color theme

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this 
theme, manage color in the software program or in the operating system for correct rendering.

● Vivid (sRGB): The product increases the color saturation in the midtones. Use this theme when 
printing business graphics.

● Photo (sRGB): The product interprets RGB color as if it were printed as a photograph using a digital 
mini lab. The product renders deeper, more saturated colors differently than with the Default 
(sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color 
space rather than sRGB. Turn off color management in the software program when using this 
theme.
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● None: No color theme is used.

● Custom Profile: Select this option to use a custom input profile to accurately control color output 
(for example, to emulate a specific HP Color LaserJet product). Download custom profiles from 
www.hp.com.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK 
button to print the job.

Change the color options

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independently from other settings. 
Click the Settings button to open the manual color-adjusment window.

NOTE: Changing color settings manually can impact output. HP recommends that only color 
graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this option 
to print color documents for photocopying or faxing. Also use this option to print draft copies or to save 
color toner.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK 
button to print the job.

Try a different print driver

You might need to use a different print driver when printing from a software program and the printed pages 
have unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

Download any of the following drivers from the HP Web site. In the US, go to www.hp.com/support/
colorljM855. Outside the US, go to www.hp.com/support. Select your country/region. Click Download Drivers 
& Software. Enter the product name, and then select Search.

HP PCL 6 driver ● Provided as the default driver on the product CD. This driver is automatically 
installed unless you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for 
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best 
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs that 
are based on PCL 5
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HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly 
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript 
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the 
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for 
use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows 
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for most 
users

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in 
Windows environments

● Might not be fully compatible with third-party and custom software programs that 
are based on PCL 5

Set the individual tray alignment

Follow these steps when text or images are not centered or aligned correctly on the printed page when 
printing from specific trays.

1. From the Home screen on the product control panel, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Print Quality

● Image Registration

3. Select the tray that you want to adjust.

4. Touch the Print Test Page button, and then follow the instructions on the printed pages.

5. Touch the Print Test Page button to verify the results, and then make further adjustments if necessary.

6. When you are satisfied with the results, touch the Save button to save the new settings.
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before beginning, 
print a configuration page from the product control panel and locate the product IP address that is listed on 
this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating 
systems and not of the HP print drivers. For more information, go to Microsoft at www.microsoft.com.

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity light 
and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is 
selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to 
this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP 
address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.
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a. Open a command-line prompt on your computer. For Windows, click Start, click Run, type cmd, and 
then press Enter.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the 
Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network 
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

HP recommends leaving these settings in automatic mode (the default setting). If you change these settings, 
you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, print drivers, and the network redirection settings.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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